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 HyperSnap-DX  Feature Overview
HyperSnap-DX brings professional quality, convenient Windows 95 and NT screen captures to your 
fingertips. It was designed for ease of use, with powerful and useful features to aid the professional as 
well as support the needs of the occasional user. Use it just a few times -- you'll find it to be 
indispensable.

Click on any of the buttons or help hotspots below to learn more about the HyperSnap-DX feature 
mentioned.    

    Save your image as a BMP, GIF, or JPEG file. GIFs can optionally be interlaced and include 
transparent backgrounds, and HyperSnap-DX can create progressive JPEGs, perfect for World Wide 
Web page use. Choose your color depth for BMP captures, too.

    
 Capture in DirectX or 3Dfx GLIDE Applications! Now you can make those special game and 

other captures you could never do before. 
    Web Authors, don't miss what HyperSnap-DX can do for you!
    Help File creators will love some of these special HyperSnap-DX options.
    Include the cursor image in your capture for a special look few capture programs can bring to you.
    The flexible and labor-saving Window capture option captures whole windows and smaller sections

of windows, highlighting the boundries of each of your options, to make a quick and accurate capture 
without eyestrain and further editing. 

    
 Minimize HyperSnap-DX to a system tray icon, ready for action with a convenient right-click 

menu.
    Choose your own HotKeys that quickly capture the entire Desktop, any Rectangle you outline, or 

the highlighted Window or Client, and automatically repeat the capture every x seconds or by using 
another HotKey.

    Automatically save each of your captures to a file by default -- you can even trigger new captures
every x seconds and have the filename incremented.

    Print your capture direct from HyperSnap-DX -- it will expand the image to the size of the paper 
and margins that you set, print multiple pages, and even add a frame, reverse, or reduce the output to 
black and white!

    Drag and Drop BMP, GIF, and JPEG files on HyperSnap-DX to open them!
    
 See what else is new in this release of HyperSnap-DX.

HyperSnap-DX is marketed by distribution of this fully functional trial version, that is only limited by 
"branding" the captures that are produced. After a reasonable time period has passed, giving you the 
opportunity to use this software (a maximum of thirty days is suggested as appropriate), you must 
purchase this software to continue to use it legally. It must otherwise be removed from your machine. 
Purchase information can be found under Registration.

 QuickHelp displays an image of all the menu options that you can click for explanations of their 
use. 

 The HyperSnap-DX Tutorial can be a great way to get to know HyperSnap-DX



 HyperSnap-DX    for Web Authors
Web Authors will be especially interested in HyperSnap-DX's convenient GIF and JPEG save options. 
Click on any of the buttons or help hotspots below to learn more about the HyperSnap-DX feature 
mentioned.

    GIF images can be saved as interlaced files, with transparent backgrounds, and three levels of 
color reduction.

    JPEGs have save options for a user-defined percentage of output quality, and the "fade-in" 
format.

    The Quick Save feature is a lifesaver -- just keep on making those captures, without 
interruption. HyperSnap-DX saves them each to an individual, sequentially named GIF or JPEG file, 
in the custom format you choose, for your later review and use.

    Include the cursor image in your Web Page image to better display your product shot or call 
attention to a specific item.

    The Window capture feature makes my day. The feature captures whole windows and sections 
of windows that are automatically highlighted, even little buttons, without squinting at the screen to 
make sure you get every pixel of the edge of a capture target. A definite eye-saver.

    The built-in Crop feature is great for making final edits to your capture without transferring it to
another program. And thankfully, there's an Undo Crop feature to mitigate the "oops!" factor.

    Capture an image of an entire web page from Netscape or Internet Explorer beyond the scroll 
bar by using the unique Auto Scroll Window capture option.

There's so much more... just use HyperSnap-DX. It will become your tool of choice.

 Back to Feature Overview
 QuickHelp



 HyperSnap-DX  for Help Authors
Help File creators will love some of the convenient capture and editing features HyperSnap-DX offers. 
Click on any of the buttons or help hotspots below to learn more about the HyperSnap-DX feature 
mentioned.

    Include the cursor image in your Help file image to better illustrate your point or call attention to a 
specific item.

    The Quick Save feature is a lifesaver -- just keep on making those captures, without 
interruption. HyperSnap-DX saves them each to an individual, sequentially named file in the color 
density you choose, for your later review and use.

    Bitmap Copy Options doesn't just perform the handy task of sending screen captures to the 
clipboard -- it sends them in the color mode you preselect. Even if you're in True Color, you can send 
16 color captures to the clipboard. Very handy for those Win 3.1 help files!

    The Window capture feature makes my day. The feature captures whole windows and sections 
of windows that are automatically highlighted, even little buttons, without squinting at the screen to 
make sure you get every pixel of the edge of a capture target. A definite eye-saver.

    The built-in Crop feature is great for making final edits to your capture without transferring it to
another program. And thankfully, there's an Undo Crop feature to mitigate the "oops!" factor.

There's so much more... just use HyperSnap-DX. It will become your tool of choice.

 Back to Feature Overview
 QuickHelp



 HyperSnap-DX    QuickHelp
This hotspotted hypergraphic will conveniently tell you everything you need to know about HyperSnap-
DX's many features. It serves as both as a quick introduction to all HyperSnap-DX can do to make screen
captures easier, as well as an ongoing reference when it is required. Each drop-down menu is included -- 
simply click on any menu selection for a complete explanation.

 Please note that keyboard shortcuts are available for many menu entries, but are omitted from this 
graphic for space considerations and the fact that you can configure certain hot keys to your own 
preference. Keyboard shortcuts are shown on the menu.
 There's more to HyperSnap-DX than meets the eye. Be sure to check out each menu item to find all of 

the most useful features.
 Special Features Page



Open
Open a GIF, BMP, or JPEG file.

You can also open these file formats 
simply by dragging and dropping a file 
to HyperSnap-DX or specifying a filename
in a command line.



Save As
Save As opens the standard
Windows Save dialog. Click
on the Save File As Type to
choose from BMP, GIF, or
JPEG file formats.

The Options button lets you set important 
options specific to currently selected picture format.



Save BMP
Select your file format from the standard Windows save dialog,
and then choose your target directory. Click on Options to
select from additional BMP format choices:

Normally, you will want to leave Auto select checked to
save your capture in the current display mode. However, you
can select from Monochrome, 16, 256, or 16 million colors by
deselecting Auto select and clicking on any other choice. Your 
choice is saved between sessions.



Save Options
Click here to open the "Save Options"
dialog. It will let you set options specific
to currently selected picture format.



Save GIF
Select your file format from the standard Windows save dialog, and then choose your target directory. 
Click on Options to select from additional GIF format choices:

Interlaced, to "fade in" when used on 
the World Wide Web

Transparent Background, to allow 
your background color or bitmap to 
display behind your graphic when used
on the World Wide Web

Color reduction may be necessary 
since the standard GIF format only 
supports 256 colors. HyperSnap-DX 
lets you choose from three options:

      - fastest: match in standard, 
balanced colormap
      - medium: optimize colormap
      - slowest, but the best quality: 
optimize colormap and dither

If the image you loaded or captured 
has 256 or less colors, these options 
are disabled..



Save JPEG
Select your file format from the standard Windows
save dialog, and then choose your target directory.
Click on Options to select from additional JPEG 
format choices:

You may choose an output quality factor to reduce 
the size of your capture file. We recommend 75%
as a good place to start, but you may wish to 
experiment.

JPEG files can be saved in the new progressive 
format for World Wide Web use. This means they 
will appear in their entirety, and then sharpen from 
their original fuzzy appearance. Not all web browsers
support this new standard.



Print/Print Setup
Selecting Print or Print Setup will provide 
the familiar Windows dialogs.



Page Setup
Choose from several custom setup options that will apply when you print your capture.

Invert Black & White is a 
great option for creating 
negative transparencies of 
screen shots -- saves on 
toner, too, if your capture 
has lots of dark areas.

Black and White Only 
eliminates greyscales for a
cleaner look in some 
instances.

Draw Frame adds a thin 
line frame around the 
image for that finished 
look.

Center Image on Page 
will make the image be 
printed in the center of the 
page, instead of in the left 
top corner.

Specify Margins in inches, cm, or mm measurements for all four sides of your captured image. 

Orientation lets you choose from Portrait, Landscape, or let HyperSnap-DX select the best fit.
Scaling offers the option to scale to a specific percentage more or less than the original, or let 
HyperSnap-DX Auto-fit the image to fill the page within your specified margins. Use Printer Resolution 
will cause your printer resolution to affect the output; i.e., if you were to choose a scaling factor of 100%, 
the bitmap will have the same number of printer pixels up and down as it had on your screen.

HyperSnap-DX will print multiple pages for long bitmaps if scaling options demand it; images too wide will 
be automatically cropped, printing only the image area that fits on the page.



Send by Email
This function will let you send the picture currently displayed in 
HyperSnap-DX window by email to someone else. You may choose 
different file formats and file name. If in doubt, select GIF format, as it is 
one of the most popular, and typical screen captures saved in this format 
produce the smallest files.

For the file name, please enter just one word or a very short phraze (max
64 letters) that describes your picture, or leave it the default SNAP if you 
don't care. Do not add file extension (a dot and anything after it) or the 
directory where the file should be saved. Your email software will select 
them automatically, and delete the file when it's been sent.



Copy
Copy the current capture to the
Windows clipboard



Paste
Paste the contents of the Windows
clipboard into HyperSnap-DX.



Clear
Clear the current capture
from HyperSnap-DX.



Full Screen (Capture)
Click to capture the entire desktop (all you can see on the screen)

 Configure Hot Keys



Region (Capture)
When clicked, a large cross cursor (+) will appear.

Click using your left mouse button to indicate where you want to start the capture area, and then release 
it. Drag the outline to enclose the area you want to capture, and click the mouse button again. The size (in
pixels) of the capture will be shown within the area.

While activated, the following additional useful options apply, and will be shown in a small window as a 
reminder. They can be toggled off using F1 or by the option: Hide Help in Region Capture.

USE MOUSE OR THE FOLLOWING KEYS:
F1: hide/show this help
Arrows: more pointer by one pixel
Shift-Arrows: move pointer by 10 pixels
Ctrl-Arrows: move pointer to an edge
Esc or Right Button: abort operation
Enter or Left Button: accept this position
+: hide/show mouse pointer

once the first anchor point is established, these tips are added:
-: hide/show rectangle size in pixels
Tab or Home: switch rectangle corner

 Configure Hot Keys



Window (Capture)
When clicked, a cross cursor (+) will appear. As you move your mouse 
around, a blinking frame will appear around the target object. You can 
capture an entire window or just a predefined area within a window.

Move to the window you want to capture, and click with your left mouse 
button to select and capture the region around which the blinking frame 
surrounds.

Click your right mouse button to abort this function.

 As you maneuver for your capture, if the highlight 
includes only a sub-window within a window you want to capture, try 
clicking on its title bar or frame.

 Active Window /Active Window without Frame (Capture) 
 Configure Hot Keys 



Active Window / Active Windows without Frame (Capture)
When either option is clicked, the active window is captured, with or 
without its framing.

If you prefer, You can capture a sub-window (an area within a window) 
using the Window (Capture) option.

 Window (Capture)



Enable DirectX and GLIDE Capture
HyperSnap-DX can capture screens from applications and games using MS DirectX technology or 3Dfx 
Glide drivers, in both Windows 95 and NT. 

To capture screens from the game, you must start HyperSnap-DX first, before the Direct-X or Glide
application is run. Then, click on the Capture menu item in HyperSnap-DX and click on Enable DirectX 
and GLIDE Capture, placing a check mark that indicates the option is active. 

When you click on Enable DirectX and GLIDE Capture, HyperSnap-DX will confirm the enabling with a 
short message, and will remind you of the hot key assigned to executing Direct X and Glide captures. 

Run the program or game normally, and whenever you're ready to capture the screen, use the hot key 
assigned to DX captures (Scroll Lock, by default). A short beep should sound to confirm the capture. 
HyperSnap will not force itself to the foreground interrupting the game, so if you want to see it, you have 
to use Alt-Tab key in the game to put it in the background and go back to regular Windows. Note: for 
some games Alt-Tab does not work; you will have to exit the game completely to return to the Windows 
desktop.

 You may choose the Quick Save or Quick Print options in HyperSnap-DX before opening your Direct-X 
application. Now, each time you capture a screen, it will be saved to a file with a sequential number (if you
used Quick Save correctly), or printed to the printer. You don't have to "Alt-Tab" out of the game to have 
your picture saved or printed.

If you used Quick Save with the option to auto-number files, you may view them all easily once you exit 
the game. Just bring HyperSnap-DX to the front and press Page Up or Page Down key to see the 
previous or next file saved. You may also view your pictures in full screen mode by selecting Full Screen 
item from the "View" menu.

 You may also use the Repeat Capture feature from the Quick Save dialog - just enter a non-zero value 
into the corresponding field there. You may, for example, enter 10 to have the capture repeated every 10 
seconds. Then switch to or start the Direct-X application, and move to the first screen you want to 
capture. Press the DX capture hot key and you will hear your action confirmed by one beep. From then 
on, auto-capture will be repeated every 10 seconds. No more beeps are emitted; the files are captured 
and saved quietly. Press the same hot key again to stop auto-capture, and you should hear 3 beeps 
confirming the cancel of auto-capture.

 You may change the hot key for DirectX and Glide captures through Options | Configure Hot Keys

 Configure Hot Keys
 Tips and Hints - How to Capture games using Microsoft DirectX or 3Dfx Glide technology



Configure Hot Keys
Hot Keys is a convenient feature of HyperSnap-DX. Even when minimized, the program stands ready to 
accept your hot key combination to immediately capture a screen! The Hot Keys (keyboard shortcuts) for 
screen captures can easily be customized to your preference.

Clear All deletes all 
Assigned Keys (Hot Keys)
Defaults returns all 
Assigned Keys to their 
original states
Revert returns all 
Assigned Keys to the 
assignments that were in 
effect when you opened 
the dialog
Enable hot-keys turns the
function on and off

Click on the button next to the function you wish to change, then execute the key combination you want 
for that function, and then click on OK. Your new Hot Key assignment will also be shown in the 
HyperSnap-DX menu option.

 Be sure not to assign Hot Key combinations that might conflict with another program. To prevent any 
problems with specific programs, you can temporarily disable HyperSnap-DX's hot keys in the dialog 
shown above.

 Repeat Last Capture
 Quick Save for information on Stop Auto Capture



Hide Help in Region Capture
When checked, this option hides the "help box" that 
appears during a Region Capture. It can be viewed
by toggling it using the F1 key.

 Region (Capture)



Display Tray Icon Only
You may check this item on the Options menu to make HyperSnap-DX display only a tiny icon in the 
system tray when iconized (the System Tray is the area to the right or bottom of the task bar, where often 
time, volume control and other icons are displayed). Use this option if you think
that the full size icon of HyperSnap in the task bar is too obtrusive.

When you see the HyperSnap-DX camera icon in the tray, you may click on it to open the HyperSnap-DX 
window, or click on it with your right mouse button to get an instant access to the program's Capture 
menu.



Toggle Menu
Hide the HyperSnap-DX menu using this menu item 
or the Control-M shortcut, which will be necessary to 
use when the menu is hidden.



Full Screen (View)
You may view the current capture full-screen by clicking
on this menu item or using the hot key combination 
Ctrl-PageDown. Striking any key or a mouse click will 
return you to the normal HyperSnap-DX view.



Previous File / Next File (View)
You can quickly browse through a directory of image files, in 
alphabetical order, using HyperSnap-DX. Open a file in the 
directory using File | Open and then use the menu items or, 
more conveniently, the PageUp and PageDown hot keys. 
HyperSnap-DX can open BMP, GIF, and JPG (JPEG) files 
and display them for you

 Remember, You can save any format to any 
other supported format, chosing the options you want, so you can 
use HyperSnap-DX to convert graphics for use on the web and 
elsewhere.

 SaveAs



Copy Format / Bitmap Copy Options
This option affects the number of colors of the bitmap pasted
to the Windows Clipboard when you use the Quick Copy
function. 

You may want to leave Auto select checked to save your 
capture in the current display mode. However, you can 
select from Monochrome, 16, 256, or 16 million colors by
deselecting Auto select and clicking on any other choice.
Your choice is saved between sessions.

 This option can save you steps if you are
in a higher color mode, like True Color or just 256 colors,
yet want to paste a bitmap into a document using the less
space-consuming 16 color or other color mode.

 Quick Copy



Quick Copy
Click this option to automatically have your capture sent to
the Windows Clipboard

 Copy Format



Quick Print
Quick Print automatically sends your capture to your printer.
The options selected in the Page Setup dialog will affect the
output.

 Page Setup



Quick Save
Quick Save, when selected (check mark appears next to option), will automatically save your capture as a
BMP, GIF, or JPEG file. The dialog appears when you check off the option.

You can specify a file name or leave the "Save to:" box blank to be prompted for a file name after each 
capture. Check Increment file name and HyperSnap-DX will save the files to the file name you choose, 
incrementing the number within the range you specify in the "start at" and "stop at" blocks.

If you enter a number (other than zero) in the Repeat first capture every [      ] seconds, and check the 
Quick Save option under the Capture menu, HyperSnap-DX will automatically save a screen capture until 
you tell it to stop, using the "Stop Auto Capture" hot key. If you change the area that you are capturing 
without stopping Auto Save, it automatically switches to capturing the newly defined area. You may also 
optionally check the “Continue on Error” box to make HyperSnap-DX ignore file errors and not abort 
Quick Save function. This may be useful, e.g. if you want to continuously “snap” pictures and push them 
to a WEB server, ignoring occasional “file busy” errors.

 These HyperSnap-DX functions are great for producing graphics for manuals or other instructional 
materials, to show and teach a series of steps within a program window. Include the cursor for extra 
emphasis on specific areas.
TIP: If Quick Save is enabled, and you open the Capture menu to change something in saving, clicking on
Quick Save menu item will just uncheck it, and Capture menu must be opened again. To prevent this, 
hold the Shift key on the keyboard when you click on Quick Save menu item - this will always open the 
dialog.

 Configure Hot Keys



Auto Scroll Window
This unique option gives you the ability to scroll down during a Capture|Window session, to capture data 
beyond what is immediately visible in a window with a vertical scroll bar.

When checked, it affects only the Capture|Window function, and when you pass over a window with a 
vertical scroll bar, the usual crosshair cursor turns into a down arrow. You may then scroll down to the 
point you wish to capture. Notice that HyperSnap-DX draws small line markers to show how much the 
subject window has moved.

Auto Scroll always starts from the top and moves downward. If you want to capture all of a window's 
contents, scroll the window to the topmost position before beginning the capture.

Note: Some applications will not allow this operation to work due to screen redraws and the way in which 
they handle scrolling. HyperSnap-DX will display an error message to advise you.

 This function is ideal to capture entire web page images, such as with Netscape or Internet Explorer, 
and file listings, too.



Restore After Capture
When this option is checked, HyperSnap-DX will automatically restore itself to view after a capture, 
whether it is open or iconized.

If you uncheck the Restore after Capture option, the HyperSnap-DX window will remain or become 
minimized (stay in the task bar) after the snapshot.

 Sometimes you'll find it very handy to keep HyperSnap-DX minimized in the task bar. You may start 
your snapshots by clicking with the right mouse button on a minimized HyperSnap-DX window or by using
hot keys, so it will print or copy images instantly.



Crop / Undo Crop
Once you have captured or opened an image, you can crop it within HyperSnap-DX. When selected, a 
large cross cursor (+) will appear and cover the entire HyperSnap-DX window.

Click using your left mouse button to indicate where you want to start the capture area, and then release 
it. Drag the outline to enclose the area you want to capture, and click the mouse button again. The size (in
pixels) of the capture will be shown within the area.

While activated, the following additional useful options apply, and will be shown in a small window as a 
reminder. They can be toggled off using F1 or by the option: Hide Help in Region Capture.

Arrows: more pointer by one pixel
Shift-Arrows: move pointer by 10 pixels
Ctrl-Arrows: move pointer to an edge
Esc or Right Button: abort operation
Enter or Left Button: accept this position
+: hide/show mouse pointer

once the first anchor point is established, these tips are added:
-: hide/show rectangle size in pixels
Tab or Home: switch rectangle corner

Undo Crop
Making this selection from the Edit menu will return the capture or graphic to its pre-crop state.



Include Cursor Image
You may optionally include the image of your 
current cursor in your capture.

 Use the cursor to highlight a point of 
interest in your capture. HyperSnap-DX can 
capture some cursors that were previously
thought invisible to all such programs. Due to 
non-standard ways in which cursors are 
handled by some programs, some custom 
cursors simply cannot be captured. 

In Windows 95, the standard set of cursors is 
captured, as well as those defined by applications. 
In Windows NT, the cursor shape may be 
incorrect if it is within the console (DOS Prompt) 
window.



Repeat Last Capture
Use this menu item or Hot Key to quickly
repeat the last capture executed.

 This is a handy feature to take sequential
or instructional captures of the same area,
or redo the last capture with a minor change.

 Configure Hot Keys



Enter License Number
Note: this subject does not apply to the owners of HyperSnap-DX commercial version.
You should enter this dialog only after you have received an email or letter from Hyperionics,
listing your license. If you do not have it yet, please click on Cancel button.

Your license letter will list your or your company name, the "Key" value, the type of the 
license and the number of licensed copies. Please enter all the data to the appropriate fields 
on the "HyperSnap-DX License" dialog. Please note also that your "key" string contains only 
capital letters from the English alphabet - there are no digits or other characters in it, except
maybe for dashes or spaces to make the key entry easier. Whenever in doubt if O shape is 
"zero" digit, or the capital "O" letter, always enter a letter.

Please enter all strings (Register To: name and the key) exactly as spelled in your license 
letter from Hyperionics. Then click below in the "License Type" frame on the radio-button 
that marks the type of the license you have purchased. Most often it will be one or more 
"Single User" licenses. If this is the case, you must also enter the correct "Number of 
Licensed Copies", that will be stated in your license letter.

After entering the above in most cases you may just click on OK button at the top right 
corner. If all was entered correctly, the "HyperSnap-DX License" dialog will just disappear. 
Your name and the license type should be listed in Help/About dialog. If you see a message 
saying "The license key you entered is invalid…", please click on OK button and verify once 
again if all the data was entered correctly. Make the appropriate correction and try again. If it
still does not work, please contact Hyperionics for the correct license key.

Occasionally you may receive a temporary license from Hyperionics - e.g. for evaluation 
purposes, or to let you work on an urgent project while your payment is in the mail or being 
processed. If you have a temporary license, you must click on the "Temporary License" 
check-box at the bottom of "HyperSnap-DX License" dialog, and then enter the exact expiry 
date in the Year, Month and Day fields. If you neglect to do so, or enter a date that differs 
from the expiry date stated in your license message from Hyperionics, the license will not 
work.

 *If the registration name is not as requested or misspelled, please contact us promptly.



 HyperSnap-DX    Support
Troubleshooting Tips:

Sometimes, particularly on slower machines, a computer may not have enough time to refresh all the
windows when you start the capture, and the HyperSnap-DX window disappears. In 32 bit 
environment applications are isolated from each other, and it's not possible to find out if all the 
windows are correctly refreshed. They are given only a limited time for the refresh, before 
HyperSnap-DX freezes the screen for the capture. If this happens, minimize the program window to 
the task bar first, and then start your capture with a hot key or the menu that pops up when you click 
using your mouse right button on the task bar.

If you are in High Color mode (16 bits per pixel, 65K colors) or True Color (24 to 32 bits per pixel, 
16M colors) and you're not satisfied with the quality of colors in GIF files, go to GIF options dialog 
from the Save As selection under the File menu item. Select "Optimize colormap" or "Optimize 
colormap and dither" option. Then make the same capture and save the GIF file again. The resulting 
colors should be much better.

Support for HyperSnap-DX is close at hand. An e-mail message will get the quickest response. Be 
certain to provide as much background information as possible.

We also welcome your comments and input for future releases of HyperSnap-DX.

e-mail: gregko@hyperionics.com

Greg Kochaniak
Hyperionics
3146 Chestnut Street
Murrysville, PA 15668, USA

Check our World Wide Web site for the latest releases, announcements, and more information about 
HyperSnap: http://www.hyperionics.com



 HyperSnap-DX    Registration
Note: this subject does not apply to the owners of HyperSnap-DX commercial version.

HyperSnap-DX is fully functional software that allows you to "try before you buy" and, like all software 
companies, Hyperionics relies on your support for continued development. In order to remove the 
Snapped by HyperSnap branding from captures that are printed, saved, or copied, you must purchase the
software. Single user registration is only $25.00; site licenses are available (see below).

You may register your copy of HyperSnap-DX on the World-Wide Web in our Web Store 
http://www.hyperionics.com, or from within the help menu. When you register HyperSnap-DX, you will 
receive a code that enables full functionality and makes you eligible for priority technical support. You will 
also be able to obtain free updates of the program through our Web page (address below) that your 
registration code will similarly enable, good until the next major release.

The single registration fee will license one copy for use on any one computer at any one time.    You must 
treat this software just like a book. An example is that this software may be used by any number of people
and may be freely moved from one computer location to another, so long as there is no possibility of it 
being used at one location while it's being used at another. Just as a book cannot be read by two different
persons at the same time.    

To register copies of HyperSnap-DX, please use the "Register" program usually provided with 
HyperSnap-DX to make payments (you can click on "Registration" in the button bar above to access it) or
go to our Web Store. You may also mail your check or money order written in US currency only, directly to
the address below, payable to Greg Kochaniak.

Greg Kochaniak
Hyperionics
3146 Chestnut Street
Murrysville, PA 15668, USA

e-mail: gregko@hyperionics.com
http://www.hyperionics.com

                
License cost:

Single licenses: $25 each or $7.50 upgrade for registered users of HyperSnap 2
Site license: $750 or $300 upgrade from HyperSnap 2 site license
(Site licenses cover a single organization for an area of up to one hundred miles (160 km) in 

radius.)
World-wide license:    $2000 or $700 upgrade from HyperSnap 2 world-wide license

HyperSnap-DX may be also registered using CompuServe SWREG forum (GO SWREG), search for 
HyperSnap-DX. The price for single user license over CompuServe is $27 due to the 15% charge they 
impose.

 License, Distribution, and Vendor Information



 HyperSnap-DX  License, Distribution,    & Vendor Info
DISCLAIMER - AGREEMENT

Users of HyperSnap-DX must accept this disclaimer of warranty: "HyperSnap-DX is supplied as is.    The 
author disclaims all warranties, expressed or implied, including, without limitation, the warranties of 
merchantability and of fitness for any purpose. The author assumes no liability for damages, direct or 
consequential, which may result from the use of HyperSnap-DX."

Note: the rest of this page does not apply to the owners of HyperSnap-DX commercial version.
The trial version of HyperSnap-DX is provided at no charge to the user for evaluation.    Feel free to share 
it with your friends, but please do not give it away altered or as part of another system.    If you find this 
program useful and find that you are using HyperSnap-DX and continue to use HyperSnap-DX after a 
reasonable trial period, you must make a registration payment. 

Commercial users of HyperSnap-DX must register and pay for their copies of HyperSnap-DX within 30 
days of first use or their license is withdrawn.    Site-License arrangements may be made by contacting 
Hyperionics.

Anyone distributing HyperSnap-DX for any kind of remuneration must first contact Hyperionics at the 
address below for authorization. This authorization will be automatically granted to distributors recognized
by the (ASP) as adhering to its guidelines for shareware distributors, and such distributors may begin 
offering HyperSnap-DX immediately (However Hyperionics must still be advised so that the distributor can
be kept up-to-date with the latest version of HyperSnap-DX.).

OMBUDSMAN STATEMENT

Greg Kochaniak is a member of the Association of Shareware Professionals (ASP).    ASP wants to 
make sure that the shareware principle works for you.    If you are unable to resolve a shareware-related 
problem with an ASP member by contacting the member directly, ASP may be able to help.    The ASP 
Ombudsman can help you resolve a dispute or problem with an ASP member, but does not provide 
technical support for members' products.    Please write to the ASP Ombudsman at 545 Grover Road, 
Muskegon, MI 49442-9427 USA, FAX 616-788-2765 or send a CompuServe message via CompuServe 
Mail to ASP Ombudsman 70007,3536.    

Microsoft, DirectX, 3Dfx, GLIDE, and any other copyrighted or trademarked names used in this 
documentation file are the property of their respective owners.



 HyperSnap-DX  Tutorial

This Tutorial can walk you through some of HyperSnap-DX's basic steps and many options available to 
you. It assumes you are familiar with Windows 95 and its basic operations.

Text Highlighted and Underlined like this is hyperlinked to further information about the topic. When you 
see text like this, if you are interested in that particular section, you should click it for further details.

The best way to learn is by doing. Try the exercises using HyperSnap-DX; you will benefit from the 
experience. You can print this tutorial by clicking on this text; you may find it easier to follow.

1. HyperSnap-DX offers three types of screen captures. You should first decide which will be best
for the task at hand.

Full Screen captures the 
entire screen.

Window is a very flexible and 
convenient method where 
HyperSnap-DX outlines 
screen sections, like windows, 
automatically, making them 
easy to capture.

Region lets you outline any 
screen area that you need to 
capture.

 No matter what you select, you can always use HyperSnap-DX's crop function to further edit your 
capture.

2. In order to view HyperSnap-DX and your capture after it has been done, make sure that the 
Restore After Capture option under the Capture menu is checked. If it is not checked, HyperSnap-DX
will be minimized (go to the task bar) and you will have to click on it to open it up again. It's not a big deal,
but now you know what that option does.

3. Let's try a capture using the Window capture option. We will need a target application to capture 
so Click here to open Windows Explorer or, for NT users, File Manager,    if one of them isn't already open.
If HyperSnap-DX isn't already open, Click here to open HyperSnap-DX.

4. Read all these bulleted steps before you proceed with the capture so you can follow them 
without referring to this file. You can optionally print this tutorial by clicking here if you haven't already.

When you are ready to begin, make sure that HyperSnap-DX is the top-most window; Windows 
Explorer should be directly beneath. Whatever window or area you want to capture should always be
visible.

Next, you will select Window from beneath the Capture menu and click on it. HyperSnap-DX will 
disappear, out of your way, down to the taskbar.

Your cursor will have turned into a little plus sign (+). Move it around, to different sections of the 
Explorer window. As you move it, notice that the blinking highlighted areas change. If you move to 
the Title Bar, the whole window is highlighted -- take your time and see all your options. Do you 
notice depending on where you move in the file windows you can include or exclude the sliding bar?

Once you have highlighted an area you want to continue to experiment with, click your left (primary) 
mouse button.

 You can also use HotKeys to initiate your captures. We'll talk about that at the end of this Tutorial.



5. After HyperSnap-DX takes the screen shot, it's program window, with your capture, will be restored to 
your view. You can change HyperSnap-DX's window size like any other program if you want to see more 
of the capture.

6. At this point, if you were satisfied with the capture, you could save it or do other things with it, but let's 
try the handy crop feature first. Cropping lets you edit your capture further by selecting an area within it
to keep, while discarding the rest. Like before, read all these bulleted steps before you proceed with the 
capture so you can follow them without referring to this file:

The first thing you will do is click on Crop from the Edit menu. Your cursor will again turn into a little 
plus sign (+); notice how the coordinates of your position are displayed in the program's title bar 
above. 

Now, Move it to the location that you will want as one corner of the section of the capture that you 
want to save and click your left mouse button. That will anchor one corner of the area you will crop 
from the capture.

Continue to move around, experiment with all that you can do. Without touching a mouse button, 
strike the minus or dash (-) key. Now, you can see the size, in pixels, that the cropped area will be. 
Hitting the key again will make the size go away. Pressing the F1 key will show you all the other 
options at your fingertips; you can click here for further crop information right now if you want more 
details on the function, or wait until later.

Now, move your cursor to enclose the area that you want to remain, and click your left mouse button.
The capture is cropped per your specifications.

If you choose Undo Crop from the Edit menu, it will undo the action and restore your original capture.

 The Region Capture action, when you select it, works very similarly except it affects the whole screen. 
Now you have experience with how that method of capture works, too.

7. Now it's time to save your capture. As before, read all these bulleted steps before you proceed with
the capture so you can follow them without referring to this file.

First, click on the Save As selection under the File menu to get a familiar-looking dialog. 
Now, click on the Save file as type: arrow. You can select from Bitmap (BMP), GIF, or JPEG (JPG) 
Pictures (file types). Choose Bitmap

Click on the Options button in this dialog. You are presented with a dialog that offers different options
for saving the file. Click on the Help button, and an explanation for these options is provided for your 
reference.

You may want to take a moment to choose first GIF and then JPEG from the Save As dialog, and 
check the options available for each of them. Again, help is only a click away.

Once you have chosen your file type and options, use the usual means of filling in a file name and 
navigating to the folder in which you want to save it, and click OK. Your capture is now saved.

 You can also copy your capture to the Windows Clipboard, and by using the Copy Format selection 
under the Edit menu item, you can choose the color density of the image that is copied.

8. You have completed this Tutorial, but HyperSnap-DX has more ways of operating and features for 
your use. The QuickHelp image map that shows all of the HyperSnap-DX menu items is a great way to 
learn about them. Just click on each menu item for an explanation.

Here are more topics that you will find of interest:



Hotkeys can also be used to initiate a capture. 

HyperSnap-DX can be minimized to the taskbar, and out of your way, but it's always ready to spring into 
action.

Click on the Capture Menu item. Note the hotkey combinations assigned to each of the three types of 
captures. If you strike any of those combinations while HyperSnap-DX is minimized, it will become active 
and capture the screen using the method you selected.

You can change the hotkey assignments to ones that you prefer by selecting Configure Hot Keys from 
the Options menu item.

Did you know that HyperSnap-DX can be used as a handy graphics tool?

Use the Open selection from the File menu item to load any BMP, GIF, or JPG file into HyperSnap-DX. 
Now you can...

Convert from one file format to another using the Save As selection under the File menu item, 
using all of the options available for each format. Yes -- that means you can convert a standard 
BMP file to a progressive JPEG or a GIF with a transparent background!
Copy the graphic to the Windows Clipboard in the number of colors you select.
Crop the graphic to just the right size -- HyperSnap-DX can even show you the area's size in 
pixels as you make your selection. Use the crop feature and press the (-) key.

See Also...
 Include Cursor Image
 Quick Save
 Quick Print
 Quick Copy



 HyperSnap-DX    Tips and Hints

This section includes good ideas on how to approach certain captures using HyperSnap-DX. Do 
you have a unique solution for a problem using HyperSnap-DX? Help your fellow users -- send it to the 
author for use in the next release's hints and tips section.

How can you capture a drop-down menu or other program feature that disappears when you press
the HyperSnap-DX hot key or menu item?

Iconize HyperSnap-DX to the taskbar, and then use one of its hot keys (e.g. Region or Window 
capture) to get the menu - it shouldn't disappear then.

Alternatively, if it does disappear, you can press the Print Screen key on your keyboard to send 
the entire desktop to the Windows Clipboard. Now, place the shot in HyperSnap-DX by using the 
Edit|Paste menu selection. Using the Crop feature will let you select the portion of the image you 
need.

You can take and use captures with HyperSnap-DX without ever seeing the program! Maybe this 
technique or a variation will be helpful to you.

Set HyperSnap-DX's options to Quick Copy from the Capture menu, and check off Restore 
after capture under the same menu item. Now, go to your word processor or other application 
and proceed with your work. When you need a capture, use the appropriate HyperSnap-DX hot 
key. The options selected will cause the capture to be sent to the Windows Clipboard, so you can 
simply paste it into your document.

 If you need a reminder for which hot key to press, click on HyperSnap-DX in the task bar with your 
right mouse button, and select the type of capture you want.
How to capture games using MS DirectX and 3Dfx GLIDE technology

You must start HyperSnap-DX first, before an application is run. Read the topic Enable DirectX 
and GLIDE Captures for instructions.

Once DX capture is enabled, you may start your application or game. Please remember, if the 
Direct-X application was running before you started HyperSnap or enabled DX capture, it may not
capture correctly.

Run the program or game normally, and whenever you're ready to capture the screen, use the hot
key assigned to DX captures (Scroll Lock, by default). A short beep should sound to confirm the 
capture. HyperSnap will not force itself to the foreground interrupting the game, so if you want to 
see it, you have to use Alt-Tab key in the game to put it in the background and go back to regular 
Windows. Note: for some games Alt-Tab does not work; you will have to exit the game completely
to return to the Windows desktop.

You may set Quick Save or Quick Print in HyperSnap-DX before going into the game. Now, each 
time you capture a screen, it can be saved to a file with a sequential number or printed, so you 
need not leave your game to save or print your capture. The Quick Save feature also allow you to
repeat a capture every 'x' seconds.



 HyperSnap    Set AutoScroll Refresh Time
Use the Options / Set AutoScroll Refresh Time menu item to change the time (in 
milliseconds) that HyperSnap-DX waits in Window Capture mode with auto-scroll for the 
window to refresh its contents in the newly scrolled-in region. If you use auto-scrolling and 
notice that parts of the picture are incorrect or missing, this means that the window you are 
capturing did not have enough time to refresh its contents after each scroll. Increasing this 
time value may help in these situations. On other occasions you may want to decrease this 
value to make auto-scroll work faster. Reasonable values for auto-scroll refresh time are 
between 20 - 1000 milliseconds.



 HyperSnap    Command Line Options
HyperSnap-DX command line options:

-install does the installation
-uninstall uninstalls HyperSnap, deletes the license too

-QuickSave turn on "QuickSave" option, that normally is not remembered between sessions.
Additional -QuickSave options to start with timed auto-save, e.g.

hsdx -hidden -QuickSave,5000,1,5 -snap:w:320:h240 -save:bmp f:\tmp\test 
hsdx -iconic -QuickSave,5000,1,5 -snap:w:320:h240 -save:bmp f:\tmp\test
hsdx -QuickSave,5000,1,5 -snap:w:320:h240 -save:bmp f:\tmp\test

will start with hidden, iconic or opened window, repeat the snap every 5000 ms (5 sec), 
increment the file name starting counter at 1 and do will stop when the counter reaches 5 
(see below for -snap and -save options description).

To disable adding numbers to the file name, set the second number in -QuickSave to 0, 
e.g.    -QuickSave,5000,0,5 - this will save snap 5 times to the same file.    Do disable max
count (the last number), set it to 0.    The capture will be repeated indefinitely, or until stop 
capture hot key (default F11) is pressed.

-fixed_title display a fixed title "HyperSnap-DX" only (do not display file name or picture size in the 
window title bar - may be needed if you want to "send keys" to HyperSnap window from 
Visual Basic or other application).

-hidden run with HyperSnap window hidden, operate with with hot keys only (must have set Quick
Print, or Quick Copy earlier, or used with QuickSave to be useful)

-nosavedir HyperSnap-DX will not save the last used disk directory (folder) when you exit it. On the 
next run of the program, it will use the value previously saved in the registry.

-nosetdir HyperSnap-DX will not restore the disk directory (folder) used in the previous run of the 
program - it will start instead with the current directory set according to the link property 
used to start the program, or current directory if started from command prompt window.

-dumpopts read from the registry and dump (save) HyperSnap options to hsdx.ini file.

-readopts read options from hsdx.ini file and save them in the registry.

-initfrom:filename This option may be used when starting HyperSnap-DX like:
hsdx -initfrom:c:\HySnap\hsdx2.ini 
where hsdx2.ini is the initialization file (with hot keys etc.) for HyperSnap-DX. Normally it 
would read the options from the registry. This feature allows you to have multiple 
configurations with different settings. 
The initial copy of the ini file may be created with
hsdx -dumpopts
command line switch.

-snap capture screen (or a portion) one time only, to immediately print or save it, then exit. 
HyperSnap Window is not displayed. Takes several sub-options separated with : (colon).
hsdx -snap:x60:y150:w200:h100 [more opts needed]
:x is X pixel coordinate to start the capture from, counted from the left. If omitted, 0 is 

assumed.



:y is Y pixel coordinate to start the capture from, counted from the top. If omitted, 0 is 
assumed.

:w is width of the area to capture, in pixels. If omitted, the area from :x to the right edge 
of the screen will be captured

:h is height of the area to capture, in pixels. If omitted, the area from :y to the bottom of 
the screen will be captured.

-open:[filename] will open and read the specified file (must have
bmp, gif or jpg extension and be valid graphics file
in that format). Then will perform the action specified
by the next option (-print or -save - possibly in a
different format) and exit. May be used to print
several graphics files in batch mode, or to translate
file between different supported formats, e.g.

To translate test.bmp to test.gif:
        hsdx -open:test.bmp -save:gif test.gif
To print test.jpg file to the default system printer:
        hsdx -open:test.jpg -print 
      

-print may be used after -snap option to cause print of the
captured picture. Takes several sub-options separated 
with : (colon).
:l      print in Landscape mode. Default it portrait
:inv invert black and white
:bw    print black and white colors only
:fr    draw a frame around printed picture
:sNN scale, where NN is % of the size, default is 100%
:af    auto-fit the picture to fill the whole page
          (but preserving the aspect ratio)
:pd    display Print Dialog, to select the printer etc.
          Prints to the default printer if :pd omitted.
Example:

hsdx -snap -print:l:fr:s75
will snap the whole screen and print in landscape mode
with a frame and scaled to 75% of the original size. 
          

-save may be used after -snap option to save the picture to a
BMP, GIF or JPEG file. Next argument should be file name,
snap.bmp, snap.gif or snap.jpg is assumed if file name is
not specified. Sub-options:
:gif        save as GIF file
:gif:i    save as Interlaced GIF file
:jpeg save as JPEG file with default quality of 75%
:jpeg:qNN save as JPEG file with quality NN% (replace NN
                    with a number, e.g. 90).
:bmp        save as BMP file (this is default, may be 
                omitted). Bitmap pixel depth is the same as screen's.
:bmp:1    save as 1 bpp bitmap
:bmp:4    save as 4 bpp bitmap
:bmp:8    save as 8 bpp bitmap
:bmp:24 save as 24 bpp bitmap 
Examples:
Snap the whole screen and save in BMP file

hsdx -snap -save c:\tmp\test.bmp
Snap portion of screen, save as 8 bit per pixel bitmap:



hsdx -snap:x50:y80:w:200:h:100 -save:bmp:8 btm.bmp 
Snap the whole screen, save to GIF file:

hsdx -snap -save:gif test.gif
Snap the whole screen, save to JPEG file with 85% quality

hsdx -snap -save:jpg:q85 test.jpg



 HyperSnap-DX  What's New
HyperSnap-DX is the new, enhanced release of HyperSnap screen capture utility for Windows 95 
and NT. 

Capture screens from applications and games using Microsoft's new DirectX or 3Dfx 
GLIDE technology. In the past, these screens either could not be captured or captured only with 
incorrect coloring, using standard screen capture technology. Our new DX Snap technology solves this 
problem for you. Capture your moments of glory in these virtual worlds, share them with friends, put on 
your web pages!

New Capture Options include two menu items to capture the last active window, with or 
without its frame. This feature was developed as a quick alternative to the other, more flexible Window 
capture that allows you to highlight and capture sub-windows as well as an entire window.

View the current image in full screen mode using a menu item or hot key.

Browse through a directory of BMP, GIF, and JPEG files using your Page Up/Page Down 
keys. Not only can HyperSnap-DX preview them for you, it displays their size and allows you to convert 
them to any supported graphic format.

Toggle the HyperSnap-DX menu on and off using a hotkey (Ctrl-M)

Check out HyperCam, another quality product from Hyperionics, that allows you to record the action from
your Windows 95 or NT screen as an AVI movie. You can include cursor movements and sound, and take
advantage of many other options, designed with the same care as HyperSnap-DX. Find out more about 
HyperCam and download a trial version from our web site at http://www.hyperionics.com



 HyperSnap-DX  Other Hyperionics Software

    
Software by Greg Kochaniak

Visit the Hyperionics Web Site at http://www.hyperionics.com to download trial and free versions
of our other software products:

 Check out HyperCam, another quality product from Hyperionics, that allows you to record the 
action from your Windows 95 or NT screen as an AVI movie. You can include cursor movements and 
sound, and take advantage of many other options, designed with the same care as HyperSnap-DX. 






